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This is a simplified version of some tools available in Avizo. If you need further 

information, please consult: 

 The Thermo Scientific EM & Spectroscopy channel in Youtube:  

 Help Guide inside Avizo workspace,  

 Technical support: fei-sw-support@fei.com  

 Avizo web site: http://www.thermofisher.com/amira-avizo   
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1. Using ImageJ to crop and change image type 

a. Change of image type 

From any terminal connected to the Recon computer, open ImageJ. To do this, follow 

the commands: 

 ssh –X 10.2.105.181 (User password: ask your local contact or user support 

(SAU) team) 

 imagej & 

This will open the program and release the terminal for further use. 

 

Import the raw file, created during the reconstruction. Go to File > Open > Raw Data, 

then go to the Sample folder and open the Recon folder. The largest file (more than 8GB), 

typically named as tomo-2048x2048x2048_8bit.b, is the raw volumetric file. 

 

Fill the Import>Raw window with image information: 

 Image type: choose the bit depth, typically 8 bit or 16 bit unsigned or 32. 

e.g. 32-bit Real 

 Width and Height: 2048 
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 Number of images: typically 2048, but it can be less if not all slices are 

reconstructed. 

 Ensure virtual stack is enabled and little-endian byte order. 

 

This is an example of a soil sample. First, check all slices to ensure the reconstruction is 

as expected. If strong rings are seen or the image contrast is not very good, (i.e. it is hard 

to separate the phases of interest), there are some parameters on the reconstruction process 

that can be changed. Talk to your local contact. 

From the header (red square), you get information regarding the image: the first number 

is the slice number along the total number of slices; the following numbers are the size 

(in pixel) of the image in Z, X and Y directions, respectively. The next information is the 

image type (32-bit), followed by the image size (32 GB). 
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To reduce the image size, first change image type to 8-bit or 16-bit. It is desirable as 

Avizo uses RAM memory for most of the processes. 

 

b. Cropping the image at ImageJ 

After the conversion is finished (it will take a while), use the square tool to choose the 

area of interest, i.e. the area to crop. Be sure that the whole image is inside the square. 

Check all slices by moving the bar (red arrow). Go to Image > Crop. 
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Tip: at the menu option, select: Plugins -> Stacks -> Crop (3D) > ok. This is a plugin that 

allows cropping 3D image stacks in all three dimensions, from a three window view of 

the image stack. The three window view demands three times more memory. So, in the 

case of lack of memory,  uncheck the "three pane view" option on startup. 

 

Save the cropped image as a raw data and use the following termination: 

tomoXxYxZsizes_nbit.b. An example of name is tomo980x1132x2048_8bit.b. Image 

dimension and type are required information to load the data in Avizo. If you want to 

open the image automatically use tiff. 
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2. How to create a 3D volume of your data 

a. Opening your data at Avizo 

Open Avizo 9.7: you will find a shortcut at your desktop. 

Click on Open Data and load your image (green rectangle). Here you have two options: 

 (Not recommended): Load the original data (~32GB). 

  (Recommended): Load the cropped image. The file name contains almost all 

required information to load the data. The only missing information is pixel size, 

which is fundamental for quantitative analysis. Knowing the objective you have 

used in your experiment, you can get the pixel size.  

Observation: If you cropped your image, use the new dimensions. If you saved your file 

in TIFF after you cropped it, Avizo will open it automatically. 

If you are not sure about the dimension or the pixel size of your file, you can also get it 

from the information file (raft.par or sample.txt) and look for "IMAGE_PIXEL_SIZE" - 

check the next few steps for this. 

 

In this example, we will open "tomo.vol” (but the recent samples always are written as 

the following: tomo2048x2048x2048_8bit.b), all required information is inside raft.par 

file. 

First, open the information file (raft.par), using Notepad++ or gedit. 

A new window will open. Here, you will find information regarding X and Y dimensions 

of your image (red box), Z dimension is always 2048, if all slices were reconstructed 

(green arrow). Pixel size (red arrow) is always shown in micrometers.  
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Then, open the volume file. 

 

The Out-of-Core Data window will open; select Read complete volume into memory. 
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The Raw Data Parameters window will open and you have to fill it with the following 

information:  

- Data type: the output of the reconstruction is 32-bit; however, it is possible to 

transform the image into 16- or 8-bit using ImageJ (Image menu > Type Submenu 

> determine the type of the active image or to convert it to another type). 

- Dimensions: you will find this in the information file (raft.par) or if you cropped 

your image, this information will be at the file name. 

After adding these parameters, the Header value (red arrow) should be zero, as it 

subtracts the file size of the requested size. If some information is wrong, the 

Header will be different of zero – double check the information you added before 

you load the image. 

- Voxel size: also defined in the information file. You will find just two values, but 

it is the same for the three axes, as the voxel is actually a cube. 
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Click OK and your image will be loaded. Depending on its size, it can take a couple of 

minutes! At this point, it is very likely that the software requests the voxel size unit – 

choose micrometers. If Avizo doesn´t request this right now, it is still possible to change 

it later. (see section f.) 

This is an example of a toothpick. 

 

b. Convert image Type 

Attach this module to the data by right clicking it and typing “Convert Image Type”. In 

output type you can determine if you want to transform your data to a different type of a 

regular 3D scalar field or an RGBA color field or  convert  a uniform scalar field of bytes 

into a Label Field (red rectangle). 

All of this transformations will  have the same dimensions and coordinates. And it will 

generate a new data after you select apply. 

 

 

 

 

 

 

 

 

c. Adding and checking the orthoslices 

The image above shows an orthoslice of a toothpick sample. This view is automatically 

loaded when you open a new image. To add more orthoslices, you have to click on your 

raw image (red arrow) and then click on Orthoslice (red box). Not all commands will be 

available as Orthoslice was. For these cases, you will need to open the dialog box (yellow 
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box), by right clicking the raw image. You can either look for all the options, by opening 

each folder (black box), or write the command (i.e. orthoslice) at the search place (blue 

arrow). 

 

Create two more orthoslices (red box). They will have the same orientation as the first 

Orthoslice. For another view of your sample, click on Orthoslice 2 and its Properties 

(green box) will appear. Change its orientation to xz (blue box) and an orange line will 

appear in your image (orange arrow).  

 

Make the same for Orthoslice 3, but choose orientation yz for a complete view of your 

image. To rotate the sample, click on the hand icon (red arrow), then click on the 

toothpick image and drag the mouse.  
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You´ll see an image like the following one. If you want to change perspective, click on 

the perspective icon (red arrow).  

 

The new image is slightly different. 
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Next step is to create the 3D volume rendering of your sample. You can right click on the 

raw image and look for Volume Rendering (red box) or you can click on the Volume 

Rendering button (red arrow).  

 

The result is the following image. If the image you create is not satisfactory, try to change 

the threshold of your colormap (red arrows) until you find the best representation of your 

sample. 
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There are plenty of options of colormap. Click on Orthoslice > Colormap Edit > Options 

> Edit colormap to modify the colors or transparency. 

 

 

Observation: You can add the colormap module to the project view. Right-click on the 

colormap icon and select Annotate>ColormapLegend. 

You can hide the orthoslices and show only the volume rendering of your sample. Just 

click on the orange box in the raw image and it will turn it to gray (red arrow). 
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d. Adding a scale bar 

To add a scale bar, you just need to click on Scalebars (red arrow) or search this in the 

searching area (orange arrow) 

 

A scale bar will appear on the left corner of your image. There are many options to edit 

it, some of them are: 

1) X and Y spatial positions (blue box). 

2) X and Y sizes (red box).  

3) X and Y frames (pink box): you enable or disable the axis. 

4) Units (yellow box): if this box is unavailable/locked (not the case here), Avizo 

already knows the units (i.e. you had included this information when you loaded 

your data).   

Suggestion: for quantitative analysis, always include this information prior to 

your analysis (Section f shows how to change this). 

5) X and Y color and width, font color and type (green box). 
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Important observation: Scalebars only make sense for a scene viewed with an 

orthographic camera (not perspective). 

e. Changing the background 

The default gray background is not appropriate for publications and reports. To change 

this, go to View > Background. 

 

Change color 1 to white and click on uniform. If the scale bar is white, it will disappear. 
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You simply need to click on Scalebars and change its color. 

 

Axes are also available. Right click on the module of the data and attach Local Axes. 

This will give the coordinate frame of the input object. The other option is available at 

View > Global Axes. In this case, the axes are at the center of the coordinate system of 

Avizo.  
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f. Correcting the units 

Click on Edit > Preferences.  

 

Then, click on Units tab and click on Spatial information only (red arrow). 
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Unclick Lock display units on working units. Avizo working unit is meter, which is 

huge comparing to our scale. 

 

Click on Display unit and change Coordinates (red arrow) to an appropriated unit 

(normally micrometer). 
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The final image is showed below. 

 

To check or include the pixel size, you can click on Crop editor and check the red box. 

If it is wrong, you can update these values. 
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g. Alternatives ways to cropping (see Section 2 to open the data at 

Avizo) 

i. Select the data (green module) and at the properties section is situated the Crop Editor 

Button (red rectangle). When you activate the crop editor, the dialog shown in the figure 

pops up. Observe that there are two mechanisms to define the new cropp. The first option 

is to define the exact slices on the X, Y and Z axis (blue arrow).  The second alternative 

is drag and move the box that appears around the data (green arrow). In that case, values 

in the text fields of the editor change according to your manipulations. 

 

Observation: There is no option to return to the original data once it’s cropped. If you 

are not sure about the result, please duplicate your data by right clicking on it and 

selecting the option Duplicate object at the top left of the dialog box. In the same part, 

there is the options of remove and rename objects. 
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ii. Select the data and right click on it. Type Volume edit in the search area of the dialog 

box. At the tool section change to Tabbox (this will create a box that you can easily drag) 

and to the shape that makes more sense in your data (box, ellipsoid, cone, cylinder or 

pyramid). If the button interior is pressed, voxels inside the region selected are replaced 

with the value(s) given by the Padding Value port. If the button exterior is pressed, 

voxels outside this region are replaced. In this case we are using Cylinder, outside (the 

background will receive a zero value) and manipulating at the Z axis. 

 

Observation: In this situation the image is not actually cropped, but the background will 

receive a zero value, which can make the segmentation a more efficiently process. If you 

have a 1024x1024x1024 data, the size will remain the same after the apply. 
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3. Filtering and Segmentation tools 

Even the best measurement and the most robust reconstruction method generate an image 

with a noise. From this image, quantitative and qualitative information can be obtained. 

Prior to image analysis, it is very common to take advantage of filters to improve the 

image quality and, consequently, facilitate the post processing.  

The main goal of filtering an image is to remove noise and this process consists on an 

image transformation, where the new image is obtained by neighborhood operations. The 

next step is the image segmentation, which is the partitioning of an image (R) into regions 

(R1, R2, R3,…, Rn) that are homogeneous with respect to some characteristic, for example, 

intensity or texture. The idea is to study each label separately from the others.  

See below some filtering and segmentation tools available in Avizo. 

Load your image. 

 

Using the Filter sandbox tool, you can test all the filters on a small piece of your image 

(little square in the image bellow). It is useful to help you to decide which filter is the best 

one for your case, in a very fast way. 
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Zoon in the image and move the square to a desirable area. 

 

Click on Filter Sandbox (light blue) and its properties will be available. You can see that 

many different filters are available (red arrow). 
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Choose the filter you want to test (in this case, it is Non Local Means). As this filter is 

very robust, it can take a while to apply to your image. You will see a red bar on the 

bottom of your screen, showing its progression. 

 

The filtered image is inside the box. 
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You can make the same procedure to test the other filters. Once you have a decision, you 

can apply the filter to the whole image by pressing Apply (red arrow). 

 

A brief description of every filter available is written bellow: 

 Bilateral: It preserves and smooth the edge. 

 Box: It is a lowpass filter that uses a box kernel.  

 Gaussian: Smoothes a image using a kernel (with Gaussian distribution). At general, 

the edge is not so preserved as the bilateral filter. 

 Median: It set the voxels value to the median based on the neighborhood. The result 

image does not look so polished because it has a pixelated look. 

 Recursive exponential: Smoothes an image based on a variable scale. It doesn’t 

preserve the edge as bilateral and also has a less intense smooth compared to gaussian. 

 Delineate: It presents contrast enhancement.  
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 Anisotropic diffusion: Provides denoising of scalar volume data, preserving and 

enhancing the contrast of edges. 

 Non-Local Means: Very useful to denoise scalar volume data. It makes the result 

image polished. 

 Unsharp Masking: This filter enhances the edges. It’s computed by a Gaussian filter 

of size kernel size. 

 FFT magnitude: Used to remove periodical noises on image. 

Tip: Sometimes using more than one filter can give you a better result. We suggest using 

Non Local Means to smooth and remove noise, and apply Unsharp Masking in the result 

image, in order to restore the edges. 

4. Segmenting the image 

To access the Segmentation menu, right click on the image to be segmented (normally it 

is the filtered image) and type Edit new label field. On its properties menu, you will see 

many available tools for segmentation. All of them are described below. 

a. Pick and Move 

This tool (red arrow) is ideal to select an unconnected segmented area of your image and 

move it to another label. In the image below, the segmented area is shown in yellow. As 

an example, let’s move one region that was wrongly assigned as pore space (black arrow), 

to the Matrix label. 

 

Using Pick and Move, click on the region you want to select. This is a 3D selection, so 

check the 3D volume to be sure that you really want to move the whole selection to 

another label. 
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Click on the label that you want this region to be moved (in this case, Matrix) and then 

click add (+). This region now is part of the Matrix label. See the final segmentation 

below, where the matrix is represented by the purple color and the pore space is in yellow. 

To show or hide a determined label, click on the small eye* (2D or 3D), next to the name 

of the label (red arrow). You can also check the label color and modify, by double clicking 

on the color box (green arrow). 

 

*Observation: In the new interface, the eyes were replaced by squares (blue rectangle). 

This is the new interface: 



 

28 

 

 

b. Brush tool 

If you have a connected piece of a label that you want to move to another label, you have 

to use brush tool. For example, there are two regions (black arrows) that were wrongly 

assigned to Background label, but it should be Matrix. 

 

Go to Brush tool (red arrow), click on Background label (black arrow). Click on Select 

only current material and, if necessary, Limited range only (if you know the threshold 

value that contains the material you want to select) – if you do not select this, all the 

Background voxels will be available for selection. 
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Select the region of interest (this is a manual painting tool, so watch out for the edges). 

Attention, this is a 2D selection; you might change the slice number to select a 3D region. 

 

Add the selection to the correct label. 
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c. Lasso tool (2D and 3D) 

This tool lets the user draw a closed contour, and selects all pixels within the contour. 

Some options are available for 2D: free hand, ellipse and rectangle. Using free hand, you 

can use auto trace, which will identify the edges of a certain area of the image. 

 

If you want to use the 3D lasso, you have first to change to Two viewers or Four viewers 

in order to see 3D and 2D simultaneously.  Then select a 3D area (left part of the image 

below) and  also check this in 2D (left part of the image). Note that you can only modify 

the selection shape in the 2D image and, in the third direction (in this case, Z direction), 

the selection is automatic. 



 

31 

 

 

d. Magic Wand tool 

Magic Wand is a region growing algorithm, which starts from a seed point and select all 

connected voxels with a gray value in a given tolerance interval. The advantage of magic 

wand over threshold tool is that it permits you to choose a single material/structure inside 

your image, i.e. if you have other materials/structures with the same gray level, but it is 

not connected to the region you want to segment, you will not select these voxels. 

Click on magic wand tool (red arrow). In this example, the image is a toothpick with a 

micro gear inside (bright region). 

 

Click on the gear (red cross) and change the boundaries values (in this case, to 240 and 

255). 
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Changing the boundaries values, you will change the result. In this example, 200 replaced 

240 (red arrow), and the gear structure changed (blue arrows). 

 

Choose the best values and add these voxels to a label field. 
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e. Propagation Contour 

This tool is a fast active contour. From a seed, which is created manually, a boundary 

front evolves. Few parameters are available to be modified, as stop time and edge 

sensitivity. In this example, we will use propagation contour to segment a specific pore 

of this soil sample. First, you have to create the seeds manually - check the figure below 

(red crosses). 

 

Then, you click on Do it* (red arrow), and the front will start evolving. After it finishes, 

you can choose the best Time (green arrow) that represents the pore space. 
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*Observation: In the new interface the phrase is “Initialize”.  

 

 

f. Blow Tool 

This tool is useful to detect edges of a region and fill its interior, however it works only 

in 2D. Click (and hold the button) on the area of interest. Drag the mouse, and the greater 

the distance from the original point is, the more the contour grows. Release the button 

when the contour is in a satisfactory place, like shown in the image bellow. The contour 

will grow in areas with homogeneous gray values and will stop when it changes abruptly, 

i.e. when it finds an edge. 

The tolerance (red arrow) controls how sharp the edge has to be in order to stop the 

contour growing - the smaller this number is, the sharper the edge has to be. If this number 

is too large, the contour will stop in weak edges.  
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After you release the mouse button, the area within the contour will be selected and you 

can add to the desirable label. 

 

 

Tip: For 2D tools (Brush, Lasso, Blow) there is the possibility of interpolating the data 

in order to make manual segmentation faster. In this case, perform the segmentation on 

an x slide and advance some slides, let's assume an advance of 10 slides (x + 10) and 

segment on it as well. Click ctrl + i (attention, i must be lowercase) and note that the 

slides between x and x + 10 are segmented following the initial and final orientation. 

Tip 2: If you keep shift selected while doing blow or lasso, you can make more than one 

annotation per slice.  

Tip 3: Use shift + i to invert the selection. 
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g. Threshold tool 

The threshold tool separates the image into different regions according to the intensity 

values. To separate the image using this tool, you just need to choose one or more 

threshold points in the gray level histogram. 

As an example, we have an image of a carbonate rock. Clearly, it is possible to see two 

different phases: matrix (light gray) and pores + background (dark gray). 

 

Click on Threshold tool (red circle) and change the gray level values (in this case, to 82 

and 255) – this way, the rock matrix will be selected.  

 

Each sample will require different numbers (threshold points). Once you have the best 

selection, you have to apply for all slices (red arrow).  
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Select Masked Voxels (red arrow), which only appears if you are using the threshold 

tool. Now, before adding a group of voxels to a specific label, you have to click on this 

button to select the voxels and, only after this, add them to the desirable label. 

 

 
 

Add the selection to a label. 
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For a 3D view of your segmented image, click on the left small eye* (red arrow) and 

check the top left window. 

* Observation: In the new interface, the eyes were replaced by squares. 

 

Once you finish the segmentation, come back to Project window (red arrow). Now you 

have a new image (.labels). This is your segmented image. Create an orthoslice and check 

the image. 
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You can create two more orthoslices and check all views. 

 

You can also create a Volume rendering of your segmented image. 
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Tip: If the Select only current material option (red rectangle) is activated, only voxels 

assigned to the current material are selected. This can be useful, for example, to select 

pores inside the rock (avoiding the selection of background). 

 

h. TopHat tool 

This tool allows the detection of dark or white areas of the image. This tool is very useful 

to pick small regions. As an example, this tool will be used to select the small pores of 

the following image.  
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First, segment the big pores using Threshold or Watershed. 

 

 

Then, the missing small pores will be segmented by TopHat tool. Click on Material5 

label (red arrow), which represents everything that is not a big pore in this image. Since 

all the unsegmented small pores are within this label, click on Select only current material 

(green arrow). Choose between black or white – in this case, as the goal is to segment 

pores, black is the best choice. Then, click on Compute Top Hat Image (blue arrow) – this 

will be an available option at this point of the segmentation process. 
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Change the range (red arrow) to adjust the selection.  

 

 

And add this region to the pore label (Material6, in this case). 
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i. Watershed 

Watershed is a robust segmentation toll and the idea consists of placing seeds in different 

regions of the image and start growing this until it touches a global maximum (barrier) of 

the image, which is determined by the image gradient. 

i. Special application: Removing the background 

Remove the background of an image can be useful in many cases, e.g. you do not want 

to crop a region of interest, either due to its heterogeneity or because you want to study 

its surface, or you want to study the pore space of the sample - if the pore space is filled 

with air, there will be no difference in gray level between the internal pores and the 

background. To remove the background, follow the next steps. 

First, load the image.  
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Apply a filter, if needed (in this case, NLM). Just be sure that the filter preserves the 

edges, which are necessary to create the gradient image. 

 

Click on Edit new label field and click on the full window (red arrow), for a better view. 

 

Using threshold tool, select as much as you can of your sample. Do not select the 

background, since this selection will be used as seeds. 
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Start growing (red arrow) the selection until you close all the internal pores (check all the 

slices, if necessary, grow a little bit more the selection). 

 

Add this selection to a new label (in this case, Material3). 
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Tip: When the selection starts growing, small voxels can be selected at the background 

area. In that case it’s useful to use Remove Islands. Select the Segmentation menu and 

click Remove Islands. This filter removes islands from the label image. In the case of 

multiple materials, check Also merge n-neighbor islands because if the length of that 

border is greater than a user-defined minimum length, the island is assigned to the 

material with the largest border, otherwise the island remains untouched.  

Tip 2: With the purpose of filling the interior of the selection without having to greatly 

expand the border, go to the Segmentation menu and click Fill holes.  

Select (red arrow) the Exterior label and add this to a new label field (in this case, 

Material4). 

 

Select Material3 (the selected area will turn red). 
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Start shrinking (red arrow) the region and stop when the red area is inside your sample. 

 

Add the selection to the Inside label. Now the whole image is divided into three different 

labels: Inside label has the seed of you sample (which also contains the internal pores); 

Material3 contains the border of the sample and Material4 has the seed for the 

background. 
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Delete Material3 (that represents the border) by pressing delete or clicking on the Remove 

the selected material (red arrow). 

 

All the voxels of this material will be moved to the Exterior label. 
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Go to watershed tool (red arrow), be sure that Inside and Material4 are marked (green 

arrow), create a New gradient image (blue arrow) and then click on Apply and create a 

new label field (yellow arrow). 

The final result is showed bellow. The background is in yellow (Material4 label) and the 

sample is in purple (Inside label). Check all slices and if you do not have a satisfactory 

result, you have to restart the process taking more care with the seeds selection, growing 

and shrinking processes. 

 

ii. Segmenting your image using a mask 

Section IX. i showed how to separate the image of your sample from the background, i.e. 

how to create a label (or mask) for each region. After this, it is possible to segment the 

sample using this mask. It is very useful, especially when you want to segment the pore 

space, which has the same gray level of the exterior (background). 
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For this example, let’s use the image of the previews section. The idea is to separate the 

pore space from the matrix. For this, let’s will use the Watershed tool again (but you can 

use any other segmentation tool). 

Go to threshold tool (red arrow), click on Inside label (green arrow) and then, Select only 

current material (yellow arrow). This way you are going to use the Threshold tool only 

on the selected material, in this case, the purple region. 

 

Select the seeds of the matrix. Make sure that there are no matrix seeds within the pore 

space. Add this selection to a new material (in this case, Material5). 

 

Click on Inside label (red arrow) again and create the pore space seeds using the threshold 

tool. 
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Move all the voxels within the Inside label to the Exterior label. 

 

Go to Watershed Tool, be sure that Material4, Material5 and Material6 are selected, click 

Create new gradient image and then, click on Apply and create a new label image. 

The final result is shown below. 
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To check if the segmentation is good, you can compare the original and segmented image, 

side by side. Go to Project, you will see that there are three new *.labels files. The last 

one is your final segmented image – create an orthoslice for this. Click on Two Viewers 

(red arrow), and choose the image you want to show by hiding/showing the orthoslice 

(green arrow). 

To make the two orthoslices move together, click on the orthoslice and then on the clip 

at slice number section (blue rectangle). Drag this clip to the other orthoslice. 
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5. Image Stack Processing (2D Recipes) 

a. Workroom 

This is a new feature that allows an image processing workflow for 2D data. It gives you 

tools available for preprocessing and segmentation. The creation of a workflow is good 

to automatize image processing if your samples need the same applications of features. 

Right click at your data and search for Image Stack Processing. Then, select creation 

workflow (blue rectangle). 

 

At the workspace you’ll see that the "reference" is the input data. There is two views (red 

rectangle) and you can adjust to see step input/step output/workflow input/workflow 

output. There is a search box at left where you can find the tools and at right is the linear 

workflow. If you want to leave the Image Stack Processing, press Quit (green rectangle). 

If you press Quit in File (top left, blue rectangle) you’ll leave the program.  

At reference (yellow rectangle) there is the main data, which means that every tool 

selected will automatically connect tho the previous output. If you want to connect with 

a different data or output, then it’s necessary to change the reference (this will be 

explained later). 
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b. Adding and removing tools 

Type in the module browser window the tool that you need (e.g. non-local means filter) 

and select it. The result image will appear at the  right side (step output) and the previous 

will appear at the left (step input). Notice that this step appears as 2 at the workflow 

section (red rectangle). You can move through the slices at Preview workflow on image 

(blue rectangle). 

 

Now, apply Unsharp Masking and then Thresholding. As you can see, every tool added 

is inserted below the selected step.  
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To remove a step, simply press the Trash button. 

 

c. Changing the reference 

The selected tool automatically connects to the preceding output, to change that you need 

to click “Insert a reference change step” at the end of the Workflow (yellow rectangle). 

For example, we’ll apply Threshold at the original data. 
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If you disable Label Blending (Blue rectangle), the background becomes black instead 

of the input data.  

 

To add an exterior data (green rectangle), it needs to have the same dimension in X, Y 

and Z axis. 
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d. How to save and apply to other data 

In the Workflow window, select Save As (blue rectangle) and then save the Workflow on 

disk. The file extension is .hxisp. 

 

To edit the recipe later, after attaching the Image Stack Processing module, browse the 

name of the recipe  and click edit workflow (blue rectangle). 

 

 

By default, only the last step of the workflow is exported. To export additional data of the 

select output icon. After you select, Quit and select Apply. 
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6. Didactic Images 

a. Setting the space 

At the section 2.c is the description of how to apply scalebar and alter the color of 

background. Now here are other options to improve your working space. 

Click on Edit > Preferences > Layout dialog. In there you can control the visibility, auto-

hide option, and position of the trackball and the compass. There are four options of 

compass available. 

In order to decide the position, the toolbar of the main viewer windons provides several 

buttons and controls. The main ones are: 

 Interact: Changes to interaction mode.  

 Trackball: Changes to viewing mode. Click at the left mouse button to alter the view 

direction. 

 Translate: Use the left mouse button to activate the translation. 

 Zoom: The vertical motion of the left mouse button controls the zoom. 

 Rotate: Rotates the camera following a clockwise rotation of one degree. 

[SHIFT]+clicking - 90 degree rotation. [CTRL]+clicking -  counterclockwise rotation. 

 Seek: Seek button+clicking on an arbitrary object - It moves the object into the 

center of the viewer window.  

 Home: Resets the camera to the home position. 

 Set Home: Sets the current position as the new home position. 

 View All: Makes all objects visible. 

 XY-, XZ- and YZ-Views: Moves the camera perpendicular to the specified 

coordinate plane.[SHIFT] – Changes to the opposite view direction. 

 Perspective/Ortho: Toggles between a perspective and an orthographic camera.  

b. 3D Rendering 

Once your space is settled, it’s necessary to give dimension to your data. The next option 

are 3D rendering that are applied by right clicking on the data (e.g., .raw) and searching 
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their names at the search box. The advantage of this tools are that they don’t need 

segmentation to generate the surface. 

Volren: It has less features available but allows a faster manipulation (if a slowdown 

occur, select the option LowRes only). 

 

Volume Rendering: This is a richer renderization. It provides different lighting and 

shade effects options. The Help at Avizo provides a Table that compares the features 

available in Voltex, Volren and Volume Rendering.  

 

Isosurface: The main difference between this one and volren or volume rendering is that 

isosurface renders just the surface pixels (not whole volume). It creates a less pixeled 

image, but it also means that it demands much more graphic resources (significant 

slowdown can happen). 

 



 

60 

 

c. Label Rendering 

Generate surface and Surface view: In this case, right click at the label, type Generate 

Surface at the search box and click on it. After, apply (red arrow), That will create a .surf 

file (blue arrow). In order to visualize it, right click and select Surface View . 

 

 

Voltex: As this module is deprecated, it’s better to use Volume Rendering instead. 
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7. Animations 

a. Orthoslice 

To help the visualization, attach a bounding box and orthoslice module to the data (right 

click and then type in the search area).  

To start an animation, enter on the Animation Director (yellow rectangle). Notice that 

all properties have a stopwatch button on the left side (red arrow). 

 

The first step is the animation of the orthoslice position. Click on the stopwatch button 

of the Slice Number section (blue rectangle) with a slice of your choice to start (this image 

has 127 slices, in the example we’ll start with 0).  

It will create a new event in the left side of the Animation interface (red rectangle) and a 

new orange diamond on the right side (green rectangle).  

 

If you need to adjust the time, it’s possible to just drag the diamond to the new position 

or put the mouse on this button and type the desired time (yellow rectangle).  
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To finish the animation, drag the master time slider (blue rectangle) to proper time (in 

this case, 00:05:00), adjust the orthoslice to a new position (e.g. 127) and click the 

stopwatch button again. Click on the Jump to start button (red rectangle) and start the 

animation (click on Play Forward button, yellow rectangle). If you want to stop the 

animation, click on the Stop button                    . 

 

b. 3D rendering and Clipping 

Attach the desirable 3D rendering (e.g. volume rendering or surface view) at your data. 

Move the master time slider to 00:05:00 and then click on the stopwatch button (green 

rectangle), select Visibility in Viewer 0. This option will create a new event, making this 

new one invisible until the time selected. Make sure the first diamond is off and the second 

is on. 

 

Sometimes can be interesting to show the orthoslice in some transparency and the volume 

gradually as the orthoslice is moving.  

To change the transparency of your orthoslice, keep the master time slider to 00:05:00, 

change the transparency None to Alpha and then click on the stopwatch button next to it 

(green rectangle). This option will create a new event, make sure the first diamond is 

None and the second is Alpha. 
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To clipp with an orthoslice, first drag the master time slider to 00:10:00, adjust the 

orthoslice to a new position (e.g. 0) and click the stopwatch button. After, select the 

Volume Rendering module, and ate the same stopwatch button on the top left, select 

Clip using orthoslice (green rectangle). This option will create a new event, make sure 

the first diamond is at position 00:05:00 and on and the second is at position 00:10:00 and 

also on.  

 

If you play the animation, you will realize that the orientation of clipping is not desirable. 

If you are in this situation, drag master time slider to 00:10:00 (the time when the 

clipping starts). Then click at the orthoslice module and select the stopwatch button at the 

top left (yellow rectangle). Click on Invert clipping orientation. Start the animation 

again and check the results. 
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Observation: If you want to clipp again at another circumstance, create another Volume 

Rendering and orthoslice and perform the clipping in the same way as described before. 

 

Tip: If you have a label data, right click on it, type Generate surface and that will result 

in a .surf file. Attach a Surface View module. Instead of leaving all the material, you can 

show only the interior materials and show them gradually as explained. For that, click at 

Transparent at Draw Style. In the buffer, select the materials you want to delete (e.g. 

exterior) and all (red rectangle); after select remove. Then proceed with the clipping. 

 

Tip 2: If you want to clip without an orthoslice, right click in the project view and create 

object. Select Other and then Clipping plane. The clip mechanism is the same as the 

orthoslice, but instead you change the position at the translate section. 

 

c. Camera Rotation 

Right click in the project view and create object. Select Animations and Scripts and then 

Camera orbit. 

 

The time slider determinates the angle (0 to 360) and action allows the modification of 

the axis of rotation.  You select the axis on the right and then select recompute. 
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Set the master time slider to the time you want (e.g. 00:10:00) and then ajust the angle 

and the axis. After, select the stopwatch button at time section and click Time: value.  

 

Adjust the master time slider to the ending point, modify the angle and click at the 

stopwatch button again. 

d. Saving and exporting 

The animation is automatically saved when the Avizo project is saved. Select file > Save 

Project in the top right of the menu.  

To create a movie you need to click on the Movie Creation Button (blue arrow).  A panel 

will appear and it permits the adjust of some parameters. Click create to export your 

movie. 
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8. Registration of images 

The registration of images becomes necessary when you have 2 equal images (or very 

similar) and you need to adjust one of them to be in the same coordinate, rotation, 

translation and/or scale factor as the other. You can do it manually (Transform Editor) 

or automatically (Register image). 

a. Transform Editor 

Once you have the two datas at your project view, apply a 3D rendering to make the 

visualization easier. In this example there is the carbonate rock used in the threshold 

section with volren attached. When you click in the green module of the data, a properties 

panel will appear at the left bottom.  

Click on the Transform Editor Button (red rectangle). You’ll notice a box with white 

vertex and six green spheres automatically appear. 
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At the Transform Editor section, the manipulator lets you choose between seven types of 

interactive manipulations (type “transform manipulators” at the Avizo User’s guide to 

see their description). The reset lets you restore transformation, rotation, scale or all. The 

undo/redo at action allows you to restore one action at time. 

 

In this example, we altered the green rock and we want to copy that to the gray rock. To 

copy/paste a transformation/rotation/scale factor you need to click on the Copy button 

(action port, blue rectangle) in the altered data. Activate the transform editor of the other 

data and press Paste button (action port). Deactivate the Transform Editor by clicking 

on its button again. 

In this situation we had the transformation to copy. If you don’t have, you can use the 

option of manipulation to manually adjust your data. In some situations, it’s better to type 

specific alterations, for that, select Dialog (manipulation port) and that will open this 

table. 
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Tip: When you have many measures of the same data, sometimes there will be little 

changes in the position of the objects from one to another. If you have the segmentation 

done for one of them, you can use the label as your guide to the alterations. For that, 

change the transparency of the orthoslice attached to the label from none to alpha and 

then align manually or from the dialog box the data orthoslice. 

 

 

 

 

 

 

 

 

 

 

b. Register Image 

This is the automatic option, but a pre-alignment is necessary if the two object are too far 

away from each other. In that case, use the Transform Editor to make them as close as 

possible.  

This example uses the same data, but the green data has a rotation different from the gray 

one. 
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Right click at the data you want to move (e.g. green data) and search for Geometry 

Transformations > Register Imagens. The Model port is related to the data that will 

change and the Reference is the data that will remain static. After that, you have to make 

some decisions about the Transform port (blue rectangle). 

 Rigid: No distortion. Only translation and rotation. 

 Shear: They are not at the same direction. 

 

After that, you have to use the Prealign port. First, press Align centers and then Aligh 

Principal Axes. That will make an optimized registration. 

 

After that, click on the apply button. The result image is perfectly aligned.  
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Attention: This is a good tool only to EQUAL objects. If your sample is deformed from 

one to another or have different characteristics, the tool will work poorly. In those 

situations, use a manually registration with Transform Editor. 

c. Image Registration Wizard 

This is a tool to connect regions that are overlapping each other. Load the two parts and 

attach a 3D volume (e.g. volren). It’s easier to see if you change the colors of the surfaces. 

Then right click on one of the data (part 1 - orange) and search Geometry Transform > 

Image Registration Wizard. Set the reference to the other part (2 - gray). Select Apply.  

 

After that, the wizard will set up Ortho Views and there will be a box around one of the 

data. At this part it’s necessary to specify overlapping subvolumes. Drag the box in the 

part 1 of the data (it should be the common region between the model and the reference) 

and then select apply. Do the same with the part 2. 
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At this part you can adjust to start the registration. Since this model is not aligned with 

the reference, select Align principal axes and then select apply. 

 

The registration is done. You can go back to previous steps or remove the Image 

Registration Wizard module. To finish the work, you need to merge the part 1 and 2.  
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Attach a Compute > Volume Operations > Merge module to part 1 and then attach to 

part 2. Select apply and then generate a Volren to see the results. 

 

d. Resample Transformed Image 

This is another way of registration, but it will move the data to the same location without 

any transformation set. It means that this tool recalculates x, y, and z axis considering the 

new position of the axis (it’s basically “sampling a volume data onto a reference lattice 

connected as input”). Attach a Resample Transformed Image (right click at the data 

and type it in the search box). 

If you select Extended at the Mode port, the result will have all the source data. Than, 

click on apply. 



 

73 

 

 

The next figure is the image resampled as XY view.  

 

It’s important to point out that your data will lose resolution in that process! That can be 

bad if you need to quantify the information in your data. 

Tip:  Use Subtract Image as a way to see what is moving or changing in your samples. 
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9. Quantification 

In this chapter, some possibilities of quantification of a segmented image will be shown. 

So, at this point, it is very important to have a good segmentation of your image, 

otherwise, you won’t have a trustworthy result. 

a. Volume of a label 

The image below shows a sandstone rock, filtered with the non-local means and 

segmented with a combination of threshold and watershed.  

 

First, move the background to the Exterior label, since this is not a region of interest, in 

this example. 

 

It is possible to rename the label, by double clicking on it. This way is easier to understand 

the final results. 
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Go to Project and check the labeled image (*.labels), the black region represents the 

background and the sample (with its pore space) is represented by both dark and light 

blue. 

 

Use the Volume Fraction tool to obtain information of the volume of pores and matrix. 
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A table will appear with the volume fraction values (red arrow). Adding both of the 

values, you see that it is not equal to 1 (i.e. 100%), just because the software also considers 

the background as part of your image, but a simple rule of three can give you the proper 

fractions. 

 

b. Separate tool 

Separation is a tool to individualize regions of an image, which can be, for example, pores 

or grains. Let’s keep the same image used in the previous example, but now, the idea is 

to transform the pore space into many individual pores (the same can be done with the 

matrix). Move all the labels to the exterior, except the one you want to individualize. In 

this case, Matrix label will be moved to the exterior. 



 

77 

 

 

And only the pore space will be left. 

 

Right click on the image and type Separate Objects. 
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The Properties window will open. This tool is very sensitive to the Marker value (which 

works like a seed), so, it might be a good an idea to vary the marker and check the final 

result, to make the best decision. For that, click on Auto-refresh (red arrow) and it will 

create a new file (*.separate). 

 

To make it easier to check the final result, click on the *.separate image and type 

Labeling. Now, every pore will receive a different color.  
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Create an orthoslice for this new image and check the result. There is a repetition of 

colors, but it does not mean necessarily that they are the same pore (somehow connected 

in 3D), it is more likely due to the high amount of pores and the lack of enough different 

colors.  

 

If you go back to the Separate Object and change the Marker Extend, you will see that 

the separation changes. The above image was with Marker = 3 and the following image, 

Marker = 10. Choose the best marker for your case. 
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c. Label analysis 

Label analysis is a tool that permits to quantify your image. In this example, we will use 

the last image, showed below, to obtain few parameters from each pore. For that, right 

click on the image and type Label Analysis. 

 

Clicking on ‘…’ (red arrow), you will open all the possibilities of measurements and you 

will also be able to create your own list of measurements. 
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Create your measure group (red arrow) and choose all the properties (from the list) you 

want to measure. 

 

Apply to your image and check the table with the results. Each pore is represented by a 

different number (red arrow), and you have the selected measures from each one of them. 

You can also export your table (green arrow). 
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And save this in different formats and work with your data in any other desirable software. 

 

OBS: Click Window > Restore Default Layout if you need to bring things back to their 

original place. 

d. Sieve Analysis 

After you applied the label analysis, you can classify you data  based on the measure. 

Attach the Sieve analysis module to your .label image (this will be the Data). Select the 

.Label-Analysis generated. Define one of the physical measure of the input analysis 

spreadsheet.  

After that, the respective histogram will appear. You can define how many categories you 

want to divide (the range for each bin) at the Sieve portion > Number of Values. The limit 

of range is represented  by vertical red lines in the histogram and the value limits are 

presented above the histogram. 
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The result is a new label image by binning components of the input label image. At left 

is an label image generated by labeling; at right is a label image with sieve analysis based 

on Area3d with 5 values. 

 

e. Connectivity 

The final example of this guide is the connectivity tool, which will give you information 

of the number of neighbors of each pore (i.e. coordination number of the pore). For that, 

you have to use the first segmentation of your pore space (before the separation) and use 

the Auto Skeleton tool. It will create a new file (*.SptGraph) and to visualize the result, 

right click on this and type Spatial Graph View. The final result is shown below. Each 

single pore is represented by one segment and two dots. The segment represents the pore 

body and the dots, either an end point (border) or a point of connection to another pore. 
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If you click on the *.SptGraph file, you will open its Properties window. Go to the Table 

option (red arrow) and click on Show and it will open the table with some information 

regarding the skeletonization. There you can find information regarding the coordination 

number of each pore and the size of the segment (pore body) in the three directions. Note: 

Z coord is always zero here because there is just one slice loaded, but in a real 3D image, 

this number is always bigger than this. 

 

 

 


